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 Action Request 
Transmittal 

Developmental Disabilities Services 
 

Lilia Teninty  
 

Number: APD-AR-17-048 

Authorized signature  Issue date: 8/4/2017 
 
Topic: Developmental Disabilities Due date: September 2017 
 
Subject: Required use of the PDF version of the Oregon ISP 
 
Applies to (check all that apply): 

 All DHS employees  County Mental Health Directors 
 Area Agencies on Aging  Health Services 
 Aging and People with Disabilities   Office of Developmental 

Disabilities Services(ODDS)  Self Sufficiency Programs 
 County DD Program Managers  ODDS Children’s Intensive  

In Home Services  ODDS Children’s  
Residential Services 

 

 Stabilization and Crisis Unit (SACU) 
 Child Welfare Programs  Other (please specify): Brokerage 

Directors; Personal Agents; Services 
Coordinators; Residential and 
Employment providers 

 
Action required: The Oregon ISP was revised to a PDF format and released to the 
field April 27, 2017.  The new format allows for more personalization and offers more 
guidance to the person completing the form. The ISP forms also offer improved 
accessibilitiy features and provide future compatability by introducing an export/import 
feature that will support the transfer of information from an existing ISP to a future 
release of a revised ISP. 
 
At the time of the release, no date was established as a required start date in using the 
new forms. That was to allow counties and brokerages time to download the free 
Adobe Acrobat Reader DC Software, necessary for taking advantage of the benefits 
offered through the revised plan.   
 
The Office of Developmental Disabilities Services will be requiring use of the PDF 
version of the ISP  beginning in September, 2017 for plans that are due in November, 
2017, and for ISP planning with people new to services. A new Person Centered 
information form for Adults and Youth, must also be used, in either PDF format or the 
most recently published MS Word format.   Use of the PDF version for the Risk 
Identification Tool, Agenda or Change form is optional.  These later forms are 
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functionally equivalent to the prior MS Word versions of the same forms. 
   
For more information on downloading the free Adobe Reader DC and answers to 
frequently asked questions, please go to  http://oregonisp.org/forms/adobe. Also 
attached is a document on how to download the free Adobe Acrobat DC software.  
 
The ISP and supporting documents can be uploaded to eXPRS, if each file size is 
reduced by "flattening" each document.  "Print to PDF" software can be used reduce 
the file size.  For more information on software options (including free tools), please  
see the attached document. Also included is a FAQ:  Oregon ISP forms in PDF.  
  
 
Reason for action: ODDS needs to establish a statewide start date for use of new 
PDF ISP forms.  
 
 
 
 
  
 

Field/stakeholder review:  Yes   No 

If yes, reviewed by: Case management Leadership Team 
 
If you have any questions about this action request, contact: 

Contact(s): Marilee Bell 

Phone: 503-947-5262 Fax:       

Email: marilee.bell@state.or.us 

 



Questions? www.OregonISP.org/support  

Preparing computer systems for new Oregon ISP forms 

Adobe software is required 

The PDF versions of the new Oregon ISP forms require specific software. The forms 

are available in two versions: Reader and Professional. Adobe Reader DC software is 

available for free download at: https://get.adobe.com/reader/ 

! When installing the free version, watch for additional “free” offers, such as McAfee anti-virus 

software. You may opt-out of downloading these additional products. They are not required in order 

to use the free Adobe Reader DC software. 

 

 Most of the interactive features of the forms work well using the free Reader DC 

version of the software. However, a few features are only available in the 

professional version. The pro features are: 

o Data import 

o Attaching files to the ISP 

 Other versions of Adobe Reader (such as Adobe Reader 9, X, XI) or other free 

PDF viewing/editing software (such as CutePDF, FoxIt, PDF Pro, PDFforge, and 

many more) may cause unexpected results, such as: 

o Unintended formatting differences like odd font sizes, unexpected spacing 

problems, or missing fields/sections 

o Glitches or crash which may result in lost data 

 

Adobe Acrobat DC Professional 

ODDS is working with DHS shared services to distribute licenses to the professional 

version of Adobe Acrobat DC software to CDDPs and Brokerages over the next year. 

Further information will be shared by ODDS as  timelines and processes progress. 

 

“Print to PDF” software is also recommended 

The new interactive PDF documents average 3-6 MB in size when completed. To 

reduce the file size, you may wish to “flatten” the document by printing to PDF.  

Various print to PDF software is available commercially. There are also free tools 

available including CutePDF and FoxIt, to name a few.  

Once correctly installed, the user can “print” the document but choose the PDF 

creation software from their list of available printers. This allows the user to save a 

flattened, non-interactive version of the document which can be more easily shared 

with others. 

http://www.oregonisp.org/support
https://get.adobe.com/reader/
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Oregon ISP forms in PDF 

Frequently Asked Questions 

 

1. How do I show or hide the purple help text? 

If a form has purple help text, there are radio buttons at the top of page one. 

Below is an example. 

 

2. Why can’t I print the purple help text? 

You can only view the purple help text on your computer screen. This keeps the 

form length at a minimum when printing. 

3. What is “hover” help text?   

You will see a  in some places. When you hover your mouse over  icons, 

after a brief pause, help text will pop up. 

4. Can I format my text with bold, italics, underlining, fonts, etc.? 

Yes, many text fields allow you to format the text: 

 Click into the text field and highlight the text you wish to format. 

 Press Ctrl-E (CMD-E on Mac) on your keyboard to open the “Form Field Text 

Properties” dialogue box. 

 If you can format text, the dialogue box will look like this: 

 
 If you cannot format text, the dialogue box will have a gray background, like 

this: 

 

5. I copied and pasted some text into the form. It kept all of the messy 

formatting. How do I clean up the formatting? 

There are two ways you can minimize messy formatting: 

o After pasting your text into the form, highlight the text you wish to reformat 

and press Ctrl-E (CMD-E on Mac). The “Form Field Text Properties” 

dialogue box will pop up. To reformat the text use these text formatting 

options. Formatting options include font type and size, bold, italics, 

underlining and more. 
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o You can also “select all” in your source document (CTRL-A on 

Windows/CMD-E on Mac) and format all of the text as 14pt Times New 

Roman ahead of time. This will help avoid messy font errors when you 

paste information into the form. It will also still preserve your other 

formatting (bold, italic, underline, etc.). 

6. How do I use spellcheck? 

Spellcheck works when you have clicked into a field. After a brief pause, red 

underlining will appear under any misspelled words within the active field. 

7. I can’t see all of the text I’m typing into a field. 

This is a PDF file format quirk. Tab or click out of the field and it will automatically 

expand to show all of the text entered. 

8. A dropdown menu is at the bottom of a page and I can’t view all of the 

options in the dropdown list. 

This can happen when a table breaks between two pages. To view the full 

dropdown list, click into the list and select one of the visible options so it 

highlights. Then use the up and down arrow keys on your keyboard to scan 

through the dropdown options. 

9. How can I personalize the forms? 

Most of these forms include two options to personalize at the top of page one: 

 When you enter a person’s name in the “Preferred name” field, most times that 

preferred name is going to replace “the person” or “the youth.” 

 When you select a “Preferred pronoun,” all instances of “they” change to “he” 

or “she.” 

10. How do I print just the Career Development Plan (CDP) section of the ISP 

form (SDS 4118)? 

 There are radio buttons at the top of the CDP section. Click “Show only CDP 

section” to hide the rest of the ISP. 

 Then click the “Print form” button on the right. 

 To show the rest of the ISP form again, click the “Show all ISP pages” 

radio button. 

11. The file size is too big to upload. How can I reduce the file size? 

There are a couple ways to reduce the file size: 

 Use a file zipping program, such as 7zip, to compress the file into a 

zipped folder. 
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 Use a “print to PDF” program, such as PDF Creator or Adobe PDF. 

Note: this option will flatten the document and remove all of the 

interactive fields. Do not do this if you need to make changes to the 

document in the future. 

12. Can I use the free Adobe Acrobat Reader DC software? 

Yes, these forms work in Adobe Acrobat Reader DC. For the best user 

experience, be sure to use the most current version of Adobe Acrobat Reader 

DC. To download and install the free Adobe Acrobat Reader DC: 

Windows: 

A. Visit https://get.adobe.com/reader/ 

B. Make sure to uncheck all unrelated offers, which may include: 

o “Install the Acrobat Reader Chrome Extension” 

o “McAfee Security Scan Plus” 

o “True Key by Intel Security” 

These optional offers are not necessary. 

C. Click the “Install now” button. You will get a prompt to save the installation 

file to your downloads folder. 

D. After it has downloaded, go to your downloads folder and double-click the 

file. Then click “Run” to start the guided installation steps. 

E. Feel free to delete the installation file out of your download folder once you 

are done with installation. 

F. To make Adobe Acrobat your default PDF viewer, see question #15. 

Note: A few ODDS form features are only available in the professional version. 

That version is “Adobe Acrobat DC” (see question 14). The pro features are: 

 Data export and import 

 Attaching files 

Mac: 

A. Visit https://get.adobe.com/reader/ 

B. Make sure to uncheck all unrelated offers, which may include: 

o “Install the Acrobat Reader Chrome Extension” 

o “McAfee Security Scan Plus” 

o “True Key by Intel Security” 

These optional offers are not necessary. 

C. Click the “Install now” button. 

Depending on your browser settings, your browser may: 

https://get.adobe.com/reader/
https://get.adobe.com/reader/
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o Prompt you to save the installation file to your downloads folder. Go to 

step D. 

o Download the installation file automatically, but not open automatically. 

Go to step D. 

o Download and open the installation file automatically. Skip to step E. 

D. Once downloaded, find the installation file (.pkg file) in your downloads 

folder and double-click it. 

Note: If you changed your settings so that downloads go to another folder; 

check that folder.  

E. Follow the on-screen prompts.  

F. Feel free to delete the installation file out of your download folder once you 

are done with installation (optional). 

G. To make Adobe Acrobat your default PDF viewer, see question #15. 

Note: A few Oregon ISP form features are only available in the professional 

version. That version is “Adobe Acrobat DC” (see question 14). The pro features 

are: 

 Data export and import 

 Attaching files 

13. I tried installing Adobe Acrobat Reader DC and got an error that I already 

have the latest version (Windows). What do I do? 

 Check if your version is DC. You can do this by opening your current version 

of Adobe Acrobat Reader and clicking Help>About Adobe Acrobat Reader. 

The current version name is at the top of the pop up window. 

 If it isn’t Adobe Acrobat Reader DC then take the following steps to repair 

the installation: 

o Go to the “Start menu” and open the “Control panel”. 

o Click “Uninstall a program” 

o Find Adobe Acrobat in the list of programs and right-click it. 

o Click “Change” 

o In the installation window that pops up, click “Repair” (you may have to click 

the “Next >” button once, before you see the “Repair” option). 

o The Installer will clean up your current Reader installation. 

o Once it is complete, try installing Reader from the website again 

(https://get.adobe.com/reader/). Follow the steps in question 12. 

https://get.adobe.com/reader/
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14. How do I get a professional copy of Adobe Acrobat DC? (Applies to 

Community Developmental Disability Programs and brokerages only.) 

You can ask for a professional copy of Adobe Acrobat DC software for case 

management staff. At a future date, we will share steps for requesting the 

professional version of Adobe Acrobat DC. 

15. How do I set my default PDF reader? 

Windows: 

 Right-click any PDF file (.pdf) 

 Click “Open with” 

 Click “Choose default program…” 

 Select Adobe Acrobat Reader DC or Adobe Acrobat DC from the 

“Recommended Programs” list 

 Make sure that “Always use the selected program to open this kind of file” is 

checked at the bottom of the “Open with” window. 

 (Note: If it isn’t listed in the recommended programs, click “Browse” and locate 

the program in your local “Program files” folder on your C-drive) 

 Now PDF files will automatically open in Adobe Acrobat Reader DC or Adobe 

Acrobat DC. 

Mac: 

 Do one of the following: 

o Right-click any PDF file (.pdf) and choose “Get Info” or 

o Select any PDF file (.pdf) and choose “Get Info” from the File menu  

 Click “Get Info” 

 In the “Get Info” window, click the “Open With” dropdown pane and select 

“Adobe Acrobat Reader DC or Adobe Acrobat DC from the list of 

recommended programs. 

 Select Adobe Acrobat Reader DC or Adobe Acrobat DC from the 

“Recommended Programs” list. 

 Once you have selected the program, make sure to click “Change All…” so 

this program is your default for when you open any PDF file in the future. 

 In the pop-up window that follows, click “Continue” to confirm this change. 

 Now PDF files will automatically open in Adobe Acrobat Reader DC or Adobe 

Acrobat DC. 
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16. Can I import data into the new PDF versions from the old Oregon ISP forms 

in Word? 

No. Once you create a document using a new PDF version, you can import into 

future versions if you have a licensed copy of Adobe Acrobat DC professional. 

17. How do I export and import data? 

*Only available with Adobe Acrobat DC* 

Using the paid version of Adobe Acrobat DC (Not Adobe Acrobat Reader DC — 

see question 14), take these steps: 

Attention: Imported data will overwrite all existing data in the destination form. It 

best to import into a blank form. We aim to fix this issue in future versions of 

forms. 

 Open the form with the data you want to export. 

 Click the button at the top of the form to export the data. 

 
 The “Export Form Data As” window will pop up. Choose where to save your 

file. Name it something unique so it’s easy to find. Click the “Save” button. 

There will be an .xml data file saved to the location you chose. 

 Open the “destination form” where you want to import the data. 

 Click the  button at the top of the form to import the data. 

 

 “Select File Containing Form Data” will pop up. Go to where you saved the 

.xml data file and select the file. Then click the “Open” button. 

 All matching data fields will import into the destination form. This will 

overwrite all existing data. 

18. How do I use the “+ Attach file(s)” button? 

*Only available with Adobe Acrobat DC* 

Using the professional version of Adobe Acrobat DC (Not Adobe Acrobat Reader 

DC — see question 14), you can attach files to the ISP form similarly to how you 

attach files to an email. The documents do not become part of the ISP body, but 

attach to the file for easy retrieval/file bundling. Note: Using this feature will 

increase the overall size of the ISP document. 

 Click the “+ Attach file(s)” button at the bottom of the last page of the ISP form. 

 The “Add Files” window will pop up. Select the files you would like to 

attach. 
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o The ISP form allows you to attach many file types. This includes, but is not 

limited to PDF, Word, Excel, JPG, PNG and TIF. 

 Attached files will be visible in the “Attachments” menu on the left. You can 

show or hide the “Attachments” menu using the “Show/hide Attachments 

menu” button, or by clicking View>Show/Hide>Navigation 

Panes>Attachments. 

 You can use the “Attachment Pane” to: 

o Search attachments 

o Open attachments to view and/or print them 

o Save out attached documents or 

o Delete attached documents. 

 The file attachment feature is available in all “Pro” versions of these forms, 

even when the “+ Attach file(s)” button isn’t visible in the form body. 

19. Sometimes the form crashes and I lose my work. What can I do to avoid this? 

 Your Adobe Reader may be out of date. See questions 12 and 13 to update. 

 It’s good to hit CTRL-S (CMD-S on Mac) to save regularly as you work. 

 You can also “select all” in your source document (CTRL-A on Windows/CMD-

A on Mac) and format all of the text as 14pt Times New Roman ahead of time. 

This will help avoid font errors when you paste into the form. It will also still 

preserve your other formatting (bold, italic, underline, etc.). 

 

Need more help? Visit www.OregonISP.org. 

http://www.oregonisp.org/



